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Indledning

Indledning

Draw er et vektorbaseret tegneværktøj. Draw tilbyder en lang række stærke værktøjer, 
som gør dig i stand til at skabe mange typer af grafik. Vektorbaseret betyder, at tegningen 
gemmes som vektorer (to punkter forbundet med en linje) frem for en samling af pixels 
(prikker på skærmen). Vektorgrafik er lettere at gemme og kan hurtigt skaleres uden tab af 
kvalitet. Til gengæld er vektorgrafik ikke egnet til fotografisk gengivelse.

Draw er fuldstændigt integreret med resten af OpenOffice.org, og det gør det meget let at 
benytte tegninger i de øvrige komponenter, f.eks. i et regneark eller et tekstdokument. Du 
skal blot kopiere tegningen fra Draw ind i det dokument, hvor du ønsker at benytte den. 
Du kan også benytte tegnefaciliteterne direkte, f.eks. i Writer, hvor du kan få værktøjerne 
fra Draw til rådighed direkte i tekstbehandling.

Funktionerne i Draw er meget udbygget. Selv om Draw aldrig har været ment som en 
konkurrent til egentlige tegneprogrammer, har det vist sig, at funktionaliteten sagtens kan 
klare en sammenligning med professionelle vektorgrafiske værktøjer. Og sammenlignet 
med andre kontorpakker, kan Draw sagtens klare sig i konkurrencen med selv de bedste.

Et par eksempler på de funktioner kan måske vække din appetit: Håndtering af flere lag, 
magnetisk gitter, linealer, forbindelser til organisationsdiagrammer og flowcharts, 3D 
funktioner, typografier og beizerkurver for blot at nævne nogle få.
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Arbejdsområdet

Arbejdsområdet

Hovedkomponenterne i Draw's brugergrænseflade vises i Figur 1 herunder.

Det store område i midten af skærmbilledet er dér, hvor du tegner dine tegninger. Det 
omgives af værktøjslinjer og informationsområder. Den nøjagtige placering af de enkelte 
elementer og hvilke elementer der vises, afhænger af din opsætning. Du kan selv flytte 
rundt på f.eks. værktøjslinjer ved hjælp af træk-og-slip. På den måde kan du selv tilpasse 
dit eget arbejdsområde.
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Figur 1:Tegnevinduet



Værktøjslinjer

Værktøjslinjer

De forskellige værktøjslinjer i Draw kan vises eller skjules efter behov.

Flere af de flydende værktøjslinjer i version 1.x er blevet 
værktøjslinjer i version 2.0.

Note Enhver værktøjslinje kan tilgås ved hjælp af Vis > Værktøjslinjer.

For at vise eller skjule en værktøjslinje, vælg Vis > Værktøjslinjer. I menuen som 
fremkommer kan du markere hvilke værktøjslinjer du ønsker vist.

Du kan også selv vælge hvilke knapper, der skal vises på de forskellige værktøjslinjer. 
Vælg Vis > Værktøjslinjer > Tilpas og vælg fanen Værktøjslinjer (se Figur 2), og vælg 
så de ønskede knapper. Hver enkelt værktøjslinje har forskellige lister at vælge knapper 
fra.

Flere værktøjslinjer er markeret med en lille pil ved siden af knappen. Pilen indikerer at 
denne knap har flere funktioner. Klik på pilen for at få vist en undermenu eller en 
flydende værktøjslinje, som viser de tilhørende funktioner (se Figur 3).
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Figur 2:Tilpasse en værktøjslinje



Værktøjslinjer

Tilsvarende kan du klikke på trekanten i overskriftslinjen på en flydende værktøjslinje for 
at vise yderligere funktioner (se Figure 4 herunder).

Måske ønsker du, at undermenuen forbliver synlig på skærmen, men et andet sted. Du kan 
gøre en undermenu til en selvstændig flydende værktøjslinje. For at gøre dette, skal du 
klikke på undermenuens titellinje, trække med musen væk fra den oprindelige placering 
og slippe museknappen.

Note De fleste knapper, som har en pil, kan blive til en flydende værktøjslinje. De 
flydende værktøjslinjer har samme egenskaber som i resten af OpenOffice.org.

Værktøjerne på de forskellige værktøjslinjer forklares her:

Værktøjslinjen Standard
Værktøjslinjen Standard ser sådan ud:

Denne værktøjslinje er ens i alle moduler i OpenOffice.org.

Kom i gang med Draw 4

Figur 3:En pil ved siden af  
knappen indikerer flere 
funktioner.

Figur 4:En pil på en flydende værktøjslinje angiver flere funktioner



Værktøjslinjer

Værktøjslinjen Streg og fyld
Værktøjslinjen Streg og fyld lader dig arbejde med hovedelementerne i din tegning. 
Ikonerne, der vises på linjen, varierer efter hvilket objekt der er markeret i din tegning.

I eksemplet herover kan du ændre farve i stregen samt fyldfarven osv. for det objekt, der 
er markeret. Hvis det markerede er tekst, vil linjen se ud som herunder

Værktøjslinjen Tegning
Værktøjslinjen Tegning er den vigtigste af alle værktøjslinjer i Draw. Den består af alle de 
nødvendige tegneredskaber til at lave tegninger. Geometriske figurer og frihåndsformer.

Tegn en lige linje

Lad os begynde med at tegne den simpleste form: En ret linje. Klik på knappen Linje  
på værktøjslinjen Tegning og placer musemarkøren der hvor du vil starte din linje. Træk 
musen mens du holder museknappen nede. Slip museknappen når du vil stoppe linjen.

Et blåt eller grønt håndtag viser sig i hver ende af linjen, hvilket viser, at dette objekt er 
det aktive objekt på tegningen. Farven afhænger af standardmarkeringsmetoden. Grøn 
betyder simpel markering, og blå betyder pege-redigere tilstand.

Hold Skift-tasten nede for at tegne en lige linje med en vinkel delelig med 45° i forhold til 
vandret.

Normalt vil en linje, der tegnes 'fanges' af gitterpunkterne hvis ”Fastgør til gitter” er 
aktiveret. Hvis du holder Ctrl nede, kan du tegne linjen helt frit. Hvis ”Fastgør til gitter” 
ikke er aktiveret, kan du benytte Ctrl-tasten til at få hjælp af gitterpunkterne mens du 
tegner.

Hvis du holder Alt-tasten nede, tegnes linjen i længderetningen uden at påvirke vinklen. 
Dette lader dig tegne en ret linje fra midten af linjen.

Linjen, som du tegner, vil have standardegenskaberne (farve og linjetype). Hvis du vil 
ændre egenskaberne for linjen, klikker du på den for at markere den, højreklikker og 
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Figur 5:Tegne en lige linje



Værktøjslinjer

vælger Streg. Du kan nu ændre egenskaberne fra dialogen.

Tegn et rektangel

At tegne rektangler er stort set som at tegne linjer bortset fra, at du benytter knappen 
Rektangel   på værktøjslinjen Tegning.

Hold Skift-tasten nede for at tegne et kvadrat. Hold Alt-tasten nede for at tegne et 
rektangel fra centrum.

Tegne en cirkel

Brug knappen Ellipse  på værktøjslinjen tegning for at tegne en ellipse eller cirkel. En 
cirkel er det samme som en ellipse, hvor to vinkelrette akser er lige lange. 

Der er også andre former tilgængelige på værktøjslinjen Tegning. I 
tidligere versioner af OpenOffice.org var disse former udvidelser til 
ellipse. Nu er mange af dem selvstændige former.

Der er tre måder at tegne en cirkel eller ellipse:

➢ Hold Skift-tasten nede for at beholde forholdet mellem akserne (dette giver som 
resultat en cirkel).

➢ Hold Alt-tasten nede for at tegne en symmetrisk ellipse eller cirkel fra centrum (modsat 
at trække fra hjørne mod hjørne). 

➢ Hold Ctrl-tasten nede mens du tegner for at lade cirklen 'fange' et gitter (gitteret kan 
være synligt eller usynligt). Emnet gitter behandles senere i denne vejledning.

Note Hvis du først trykker (og holder) Ctrl-tasten, før du klikker på en af disse knapper 
(Linje, rektangel, ellipse eller tekst), oprettes med det samme en figur med standard 
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Figur 6:Tegne et  
rektangel

Figur 7:Tegne en 
cirkel 



Værktøjslinjer

størrelse, form og farve. Du kan senere ændre disse egenskaber.

Tekst

Brug tekstværktøjet  for at skrive tekst og vælge skrifttype, farve, størrelse og øvrige 
egenskaber. Klik på et tomt område i arbejdsområdet for at skrive tekst på det sted. Hvis 
du klikker på et objekt, vil teksten blive placeret i midten af objektet og blive bundet til 
objektet. Objektets kanter bliver tekstens afgrænsning.

Når du er færdig med at skrive din tekst, skal du klikke inden i tekstrammen. Klik på 
Enter for at gå til tekstlinjen. Dobbeltklik på teksten for igen at åbne teksten for 
redigering.

Når du skriver tekst, vil den øverste værktøjslinje indholde de sædvanlige tekst­
formateringsværktøjer, f.eks. indrykning, justering og tabulatorstop.

Du kan ændre formatering af skriften for alle tekster. Vinduet Typografier og formatering 
virker også her, (vælg Format > Typografier og formatering eller klik på F11 for at 
åbne dialogen), så du kan oprette typografier, som du kan genbruge i andre tekstrammer 
nøjagtigt på samme måde som i f.eks. Writer..

Tekstrammer kan også have fyldfarve, skygger og andre egenskaber, som andre objekter i 
Draw. Du kan rotere rammen og derved skrive teksten på skrå eller i vinkel. Disse 
egenskaber er mulige ved at højreklikke på objektet.

Brug værktøjet Forklaringer som findes på værktøjslinjen Tegning for at oprette 
talebobler af forskellig slags.

Farvelinjen
For at få vist denne linje, skal du vælge Vis > Værktøjslinjer > Farvelinje. Herved vises 
farvelinjen i bunden af arbejdsområdet.

Med denne værktøjslinje kan du let og hurtigt vælge farve til et objekt i din tegning. Den 
første boks i linjen angiver ingen farve eller transparent (gennemsigtig).

Farvepaletten, som er vist som standard, kan ændres ved hjælp af Formater  > Flade som 
vist i Figur 8. Vælg fanen Farver.

Hvis du klikker på knappen Åbn (markeret med en cirkel), kan du ved hjælp af 
filvælgeren hente en ny palette (filendelse .soc). Adskillige paletter er leveret sammen 
med OpenOffice.org. For eksempel paletten web.soc ,som er en palette specielt velegnet 
til at tegne billeder, som skal bruges på internettet, idet disse farver altid kan vises præcist 
og korrekt i en webbrowser med skærmopløsning med 256 farver.
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Boksen farvevalg lader dig også vælge individuelle farver ved at ændre eller justere de 
numeriske værdier i felterne til højre. Du kan også klikke på Rediger for at vise en 
dialogboks (vist i  Figur 9):

Du kan benytte farveskemaerne CMYK (Cyan, Magenta, Yellow, Black), RGB (Red, 
Green, Blue) eller HSB (Hue, Saturation, Brightness).
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Figur 8:Ændre farvepaletten.

Figur 9:Definere farveskemaer
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Værktøjslinjen Indstillinger
Denne værktøjslinje giver dig mulighed for at aktivere eller deaktivere forskellige 
tegneværktøjer. Værktøjslinjen vises ikke som standard, men kan findes ved hjælp af Vis 
> Værktøjslinjer > Indstillinger.

Ikonerne på denne værktøjslinje kan inddeles i tre grupper: Det magnetiske gitter, 
gribelinjer og gribepunkter. For at gribe et gitter, linjer eller punkter kræver tre trin:

1) Vis gitter, linjer eller punkter.

2) Klik på den korrekte gribe- eller fangeikon

3) Træk objektet tæt hen til det sted du vil fastgøre objektet til.

Det magnetiske gitter

Det magnetiske gitter repræsenterer et gitter, som består af punkter som objekter kan 
fastgøres til. Klik på knappen Vis gitter for at vise gitterpunkterne, klik så på Fastgør til 
gitter for at aktivere. Arbejdsområdet fyldes nu af små prikker som vist i Figur 10.

Når gitteret er aktiveret, kan former let placeres ved at bruge gitteret som hjælp. I det 
følgende eksempel er objektets håndtag placeret præcist på prikkerne i gitteret.

Afstanden mellem de enkelte prikker i gitteret kan defineres i Gitterindstillingerne: 
Funktioner > Indstillinger > OpenOffice.org Draw > Gitter.
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Med dialogen i Figur 11 kan du foretage følgende indstillinger:

• Vertikal og horisontal afstand mellem punkterne i gitteret. Du kan også angive 
måleenhed.

• Opløsning er størrelsen af kvadrater eller rektangler i gitteret. Hvis opløsningen er 
1 cm horisontalt og 2 cm vertikalt, vil gitteret bestå af rektangler, som er 2 cm høje 
og 1 cm brede.

• Inddeling er yderligere punkter, som viser sig langs siderne på hvert rektangel i 
gitteret. Objekter fastgøres til inddelinger såvel som til gitterpunkterne.

• Billedpunkter i Fangområde angiver, hvor tæt du skal placere objektet til et punkt 
for at fastgøre det til punktet. 
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Figur 10:Arbejdsområde med et gitter
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Linealerne
Du ser linealerne øverst og i venstre side af arbejdsområdet (se Figur 12). De viser dig 
størrelsen på de enkelte objekter. Linealerne viser herudover musens placering, for at du 
bedre kan placere objektene præcist.

Sidemarginer vises også på linealerne. Du kan ændre marginer direkte på linealerne ved at 
trække i dem med musen. For at ændre måleenheden for linealerne skal du højreklikke og 
vælge en ny måleenhed.
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Figur 11:Indstillinger for gitter

Figur 12:Linealer i en tegning
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De to linealer kan have forskellige måleenheder. 

Linealerne benyttes også til at håndtere håndtag og fanglinjer, hvilket gør placering af 
objekter lettere.

Statuslinjen

Statuslinjen finder du nederst i vinduet. Det midterste område er specielt relevant i 
OpenOffice.org Draw.

Størrelser angives i den aktuelle måleenhed (ikke at forveksle med måleenheden på 
linealerne). Denne måleenhed sættes i Funktoner > Indstillinger > OpenOffice.org 
Draw > Generelt. Her kan du også indstille målestoksforholdet for siden. En anden måde 
at ændre målestoksforholdet er at dobbeltklikke på tallet i statuslinjen.

Avancerede funktioner

Draw her flere forskellige avancerede funktioner, som er værdifulde i særlige tilfælde.

Dupliker
Denne funktion duplikerer en form samtidig med, at du ændrer en eller flere egenskaber 
for duplikaterne.

For at starte duplikering skal du markere et objekt (eller en gruppe af objekter), vælg så 
Rediger > Dupliker.

Denne dialogboks vises:
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Figur 13:Dialogboksen Dupliker
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Du kan vælge:

• Antal kopier.

• Forskydning langs X og Y akser mellem to kopier.

• Vinkel for rotation mellem to kopier.

• Forskydning af størrelsen mellem to kopier.

• Farven for første og sidste kopi.

Eksempel:

Slutresultatet af en duplikering er en ny gruppe.

Ton over...
Ton over... transformerer en form til en anden. Resultatet er en ny objektgruppe.

For at udføre en overtoning skal du først markere to objekter (hold Skift-tasten nede mens 
du vælger begge objekter efter tur) og vælg så Rediger > Ton over... Følgende dialogboks 
viser sig:

Her er et eksempel:

Vi starter med to figurer:
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Figur 14:Dialogboksen Ton over
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 ...og udfører en overtoning for at opnå følgende effekt:

Udveksle objekter med andre programmer
For at gemme en tegning fra Draw i et andet format, skal du vælge Filer > Eksporter. 
Standardvalget for at eksportere er html-formatet ved hjælp af konverteringsguiden.

Guiden opretter så mange websider, som der er sider i dit Draw-dokument. Du kan 
eventuelt vælge at vise websiderne i frames (rammer) med en navigationsmenu og kan 
oprette en indexside 1. 

Når du bruger denne guide, kan du til enhver tid vælge at oprette websiden ved at klikke 
på knappen Opret.

1 Denne guide er nøjagtig den samme som i OpenOffice.org Impress.
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➊ Vælg et design for siderne, 
enten ved at vælge et 
eksisterende design eller ved 
at oprette et nyt.

➋ Vælg hvordan du vil 
navigere på websiderne: 
Standard HTML-format, 
Standard HTML md rammer 
eller kodede sider (ved hjælp 
af  ASP eller Perl; Desværre 
har OpenOffice.org ikke 
understøttelse af PHP).
# Kodede sider er ikke nævnt 
på grafik. Kun Automatisk 
og WebCast! #

Du kan også oprette et 
titelblad.

➌ Afgør hvordan billederne 
skal gemmes (GIF eller JPG) 
og tilhørende parametre. 
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➍ Indtast detaljer vedrørende 
forfatteren.

➎ Vælg navigationsknapper. 
Hvis du ikke vælger en 
knaptype, vil OpenOffice.org 
oprette tekstbaseret 
navigation

➏ Angiv farveskema for de 
oprettede sider. Du kan 
gemme skemaet, så du kan 
bruge det en anden gang. Så 
fremkommer det i listen på 
guidens første side.

På eksporter-siden benyttes standardværdien, hvis du ikke angiver en anden værdi. 
OpenOffice.org understøtter flere forskellige vektorbaserede og bitmapformater.
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